This macro was written to allow estimation of area and volume by the Cavalieri method; and to provide counting frames for physical and optical dissector methods. Some additional point counting templates were added to version 2. Finally, this version adds cycloids, which were left out until the NIH Image macro interpreter was speeded up. Some errors were corrected that gave very ugly looking, though still accurate, point count crosses in the Cavalieri 2.0 macros. Again, the better way to make the crosses wasn't practical until the Image macro interpreter was improved.

**This version is aspect ratio aware and will scale templates according to the aspect ratio.** To use it with images that have been corrected for non-square pixels, set the aspect ratio to 1.0.

What it does:
A. Allows the user to place point counting templates over an image to perform stereological estimates:
   1. area and volume by the Cavalieri method;
   2. volume, surface and length density;
   3. numerical density;
   4. record up to 4 categories of objects or intersections.
B. Allows the user to place a counting frame of known area over an image for counting objects using optical and physical dissectors.
C. Provides a random number generator for sample selection.
D. Allows superimposition of templates of different patterns, scales, or colors to create complex templates.

User Control:
- Set the scale, with an aspect ratio;
- Set the color and line thickness;
- Set the area of template tiles;
- Set a boundary zone between the template and image edges;
- Set the diameter and color of counting markers;
- Select random tile placement;
- Superimpose successive templates to the same origin.

**Macros for Setting Parameters**
Many of these were placed at the bottom of the macro menu list.

**Set Scale [S]**

Purpose: Set the scale in microns and enter an aspect ratio to correct for non-square pixels.

Control: Press [S] and then enter the pixel/micron value appropriate for the combination of objective and optivar setting in use.
Cavalieri 3.0

Then enter the aspect ratio. This ratio will change for any combination of camera, frame capture board and computer display.
Note: Opening this macro and then cancelling will allow tile and counting frame areas to be in terms of pixels. If using images that have been "squared", correcting for non-square pixels, or working from scanned micrographs assumed to be square, then set the aspect ratio to 1.0.

Use: Upon starting Image or whenever the magnification is changed.
This performs a similar function as going through the Spatial Calibration command under the Analyze menu.
Default: Set Scale sets the units as micrometers. Pixels are the default unit when Image is first started. If some unit other than micrometers is desired, then use the Set Scale... Analyze menu item and leave this macro alone.

Read Scale [A]
Purpose: Display current scale, aspect ratio, tile area and line length.
Control: Press [R].

Set Tile Area [T]
Purpose: Enter the area for the tiles in a sampling grid.
Control: Press [T] and then enter the desired area, in the units displayed.
Use: Whenever changing the area or length of a sampling tile.

Line Lengths
Lengths for cycloids or line density templates are set by entering an appropriate area, i.e. the square of the desired length.

Set Grid Color [G]
Purpose: Sets the line color of templates and counting markers (sets the foreground color).
Control: Select the macro and enter an integer number into the dialog.
A list of available colors is given in the Info box at the lower right of the monitor. Default is 1, which is red. This macro sets reserved entries for 6 colors (Image menu Options, LUT Options...). Colors may be changed at any time.

Set Random Start Area
Purpose: Choose whether the template origin will be at the upper left corner of the image, or whether the origin will be randomly placed in an area of "n" multiples of the tile area.
Use: Default is 1, which causes the template origin to be randomly placed within an area equal to 1 tile located at the upper left corner of the image. Entering "0" will force the template origin to the upper left corner (i.e. randomly placed in a tile area of zero units).
Cavalieri 3.0

Set Margin Width
Purpose: Enter a width for a margin between the template and the top, left and right edges of the image.
Use: Enter a value.
Note: This is intended to allow recognition of objects at the edges of templates. Set to zero to get maximum number of tiles.

Set Line Thickness
Purpose: Set the line width for any of the templates.
Use: Select the macro from the menu and enter the desired line width, in pixels. The default is a line width of 1 pixel.

Set Spot Diameter
Purpose: Set the diameter of the markers used for point counting.
Use: Select the macro from the menu and enter the desired diameter. The default is a diameter of 5 pixels.
Macros for Counting Points and Objects.
- Identify Sample [I]
- Count First Object [1]
- Count Second Object [2]
- Count Third Object [3]
- Count Fourth Object [4]
- Done with Counts [D]

Purpose: Count and record up to 4 categories of objects on an image, marking each category with a colored marker -
1. Counting points over areas for estimating volume by the Cavalieri method;
2. Counting intersections of profiles with templates for estimating length, surface or numerical densities;
3. Counting objects within an area.
4. Set big spots to mark items for physical disectors.

What they do:
The "Identify Sample" command asks for three identifiers, Slide Number, Section and Other. It also records the area of the tile, counting frame or a drawn line.
Each of the Count Object commands records cursor clicks over the image. Each click counts an object within a selected category and leaves behind a colored spot to aid the user.
Each object category has its own color. How it Works: Selecting a category initializes counting for that class of object. Counts are recorded until the user clicks the cursor in the NIH Image menu bar. A beep indicates that counting for the category is terminated. Categories may be counted in any order, or skipped.
Pressing "D" terminates counting for that sample and records all values in the Measurements Box.

To Use:
1. Put a grid over the image, see below;
2. Identify Sample [I];
3. Select a category by pressing 1, 2, 3 or 4;
4. Count an Object, place the cursor over each point to be counted and click the mouse button - a spot will appear to mark the event;
5. When done counting each object category move the cursor off the image, to the Image menu bar and click;
6. Move the cursor over the image and select the next object category to count, repeating steps 4. and 5.;
7. Select Done with Counts [D] when finished counting objects for the sample (this step writes the data to the results);
8. Repeat steps 1 through 6 for each sample image;
9. Save data files for each group of samples (such as samples grouped by animal or experiment) by displaying measurement [cmd 2 or Analyze Menu] and then selecting ‘Save’ or ‘Save As...’ from the Files Menu. Be sure to save the data measurements to the User Files folder, not to the Image application’s folder.
Cavalieri 3.0

Notes:
1. The cursor must be over the image before pressing 1, 2, 3, 4, or D.
2. Clicking the mouse too rapidly will result in lost points. Don't click until you see the colored dot from the previous point appear.
3. You may skip any object category or select categories in any order. The number of counts for any skipped category defaults to 0.

Sample Results:

<table>
<thead>
<tr>
<th>Sample</th>
<th>Slide</th>
<th>Section</th>
<th>Other</th>
<th>Area/length</th>
<th>2=area</th>
<th>First</th>
<th>Second</th>
<th>Third</th>
<th>Fourth</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Number</td>
<td>Number</td>
<td></td>
<td></td>
<td>I=length</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>5</td>
<td>40</td>
<td>788.3</td>
<td>2</td>
<td>33</td>
<td>80</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>6</td>
<td>40</td>
<td>788.3</td>
<td>2</td>
<td>45</td>
<td>47</td>
<td>9</td>
<td>15</td>
</tr>
<tr>
<td>3</td>
<td>12</td>
<td>5</td>
<td>40</td>
<td>788.3</td>
<td>2</td>
<td>25</td>
<td>65</td>
<td>15</td>
<td>5</td>
</tr>
</tbody>
</table>
Counting Templates

Purpose: Create point counting templates for stereological estimates of numbers, areas, surfaces or lengths.

Note: Since these templates are drawn directly onto the image you may want to duplicate the sample image before application. "Duplicate" is under the File Menu.

Superimposing Templates

Although the default behavior is to place each template randomly on the image, each new template may be aligned to the same starting point as its previous template. The Control key is held down while selecting the template from the menu. This new template must be selected from the menu.

This enables successive counts on the same image using templates appropriate for objects of differing scales, or to create complex templates. Altering line width and line color may aid in distinguishing between superimposed templates. If the control key is not held down each successive template on an image will originate randomly from within the same region as previous templates, unless the Set Random Area macro parameter is altered. The template of spots is offset to superimpose in the upper left corner tiles formed with squares or crosses.

Point Count Squares [P]

What it does: Creates a grid of lines over the image.

To Use:
1. Set up by setting the scale, tile area and template origin (if changing from the default).
2. Press ‘P’;
3. **To count:** See the previous section.

Staggering Templates

The following templates can be staggered by holding down the 'Option' key while selecting the template from the menu. (Yes, these templates work while holding down both the Option and Control keys.)

Point Count Crosses [X]

What it does: Draws a grid of crosses over the image. Each arm of a cross equals 1/8 the length of one side of the corresponding square.

To Use:
1. Set up by setting the scale, tile area and template origin (if changing from the default).
2. Press ‘X’;
3. **To count:** See the previous section.

Staggered Crosses [Option key]

What it does: Draws a grid of crosses over the image. The first column begins at the random starting point, and each alternating column is offset downwards by 1/2 the height of the area.

To Use:
1. Press ‘Option’ while selecting Point Count Crosses from the macro menu;
Cavalieri 3.0

**Point Count Spots [O]**
What it does: Draws a grid of dots over the entire screen, each dot represents the upper left corner of a square area.

To Use:
1. Set up by setting the scale, tile area and template origin (if changing from the default).
2. Press ‘O’;
3. To count: See the previous section.

**Staggered Spots [Option key]**
What it does: Draws a grid of dots over the entire screen. The first column begins at the random starting point, and each alternating column is offset downwards by 1/2 the height of the area.

To Use:
1. Press ‘Option’ while selecting Point Count Spots from the macro menu;

**Length Density:**
Each template presents an array of line lengths for estimation of surface area. Please note that length density estimates require the use of anisotropic samples or vertical sections.

**Length Density [L]**
What it does: Draws a grid of horizontal line segments over the entire screen, the left end of each line represents the upper left corner of a square tile. Each line has length equal to the square root of the tile area.
To Use:
1. Set up by setting the scale, tile area and template origin (if changing from the default).
2. Press ‘L’;
3. To count: See the previous section.

**Staggered Length Density [Option key]**
What it does: Alternating columns are offset downwards by 1/2 the height of the area (1/2 line length). Places twice as many lines.

**Vertical Density [K]**
What it does: Draws a grid of vertical line segments over the entire screen, the upper end of each line represents the upper left corner of a square tile. Each line has length equal to the square root of the tile area.
To Use:
1. Set up by setting the scale, tile area and template origin (if changing from the default).
2. Press ‘K’;
3. To count: See the previous section.

**Staggered Length Density [Option key]**
Cavalieri 3.0

What it does: Alternating columns are offset leftwards by 1/2 the height of the area (1/2 line length). Places twice as many lines.

To Use:
1. Press ‘Option’ while selecting Vertical Density from the macro menu;

Cycloids

Please note that surface area estimates made with cycloids require the use of anisotropic samples or vertical sections.

Horizontal Cycloids [C]
What it does: Draws a grid of cycloids oriented "horizontally". Each cycloid is centered in a square of area equal to the Tile Area. Each cycloid's length equals the square root of the Tile Area (a side of a tile).

To Use:
1. Press 'C'.

Staggered Cycloids [Option key]
What it does: Draws a staggered grid of horizontal cycloids. Alternating columns are offset vertically by 1/2 cycloid length.

To Use:
1. Press ‘Option’ while selecting Horizontal Cycloids from the macro menu;

Vertical Cycloids [B]
What it does: Draws a grid of cycloids oriented "vertically". Each cycloid is centered in a square of area equal to the Tile Area. Each cycloid's length equals the square root of the Tile Area (a side of a tile).

To Use:
1. Press 'V'.

Staggered Vertical Cycloids [Option key]
What it does: Alternating columns are offset laterally by 1/2 cycloid length.

To Use:
1. Press ‘Option’ while selecting Vertical Cycloids from the macro menu;
Cavalieri 3.0

Set Counting Frame Area

What it does: Set the area of a counting frame for optical disectors. This area is independent of the area used for the grid templates.

To Use:
1. Select the macro and enter a value, in the units set by Set Scale.

Counting Frame [F]

What it does: Creates an image of a counting frame centered on the image. The frame's size is specified by the Counting Frame Area Macro.

The length of the forbidden zones are 1/4 of the frame side length, provided the frame is not too large - then they extend to the image edges.

To Use:
1. Press ‘F’;

Measure Length

What it does: Measure the length of a linear structure prior to counting objects along it.

To Use:
1. Select the appropriate line tool;
2. Select Measure Length.
Upper Limit for Random Numbers [U]
What it does: Sets an upper limit for random integers.

To Use: Press ‘U’ and enter the desired value or accept the default.

Random Numbers
What it does: Displays a random integer value between 1 and the upper limit.

To Use: Press ‘R’.

List of Random Numbers [N]
What it does: Produces a list of random numbers between 1 and an upper limit. The list is stored as a series of measurements.

User Control: The user is prompted for an upper limit and how many numbers to generate for the list. The user may save this to file, as an Excel file, or print it.

Note: This macro can drop this list into an active set of point counting measurements, be careful.

To Use:
1. Select List of Random Numbers
2. Enter the upper limit;
3. Enter the number of random integers desired.
Application Notes

Physical Disector Counts.

There are several ways to compare the two images from the adjacent reference and lookup sections. The most efficient method will depend upon the sample and your resources. Sample alignment can make this approach very problematic and eye-straining. Relatively small objects, lack of prominent landmarks, or too many objects can make use of un-aligned images too difficult. Two monitors can allow a straightforward approach - one displays a captured image, while the other presents a live image. Live paste is elegant, but requires a rotating stage, or rotatable camera. Further, having only 1 LUT makes it difficult to tell to which layer a given sample object belongs. The latter problem can sometimes be overcome by pseudocolor and LUT transformations (such as inverting one image) so that color differences will identify structures overlapping during the live paste. Putting large splotches of a contrasting color over the items on the reference section may allow distinction.

The most difficult aspect of physical disector-based counting with superimposed images is that of rotational alignment. The rotational alignment macro available on zippy.nimh.nih.gov is useful for manually selected fiduciary marks. Alternatively, the reference and lookup sections may be converted to a stack and aligned with the rotational alignment stacks command. A plug-in is also available on zippy which allows alignment based on thresholding. Once images are aligned, subtracting or dividing one image by the other may also help to identify objects common to both sections.

A simple method for a physical disector involves marking the reference image with large, bold splotches on the objects to be counted. Then boost the contrast and print the image onto mylar transparency film. Capture the lookup image and hold the mylar over the monitor and rotate it until your landmarks or objects align. Next, run the macros to create a Counting Frame, use the point counting macros to count the objects present in the lookup frame, but not in the reference frame. For doubled sampling efficiency, run the Identify and Counting macros again to count those objects unique to the mylar (reversing lookup and reference images).

Cheaper yet, tape a clean piece of mylar over the monitor and mark counting objects and fiduciary points with an erasable marker. This is usually much faster than waiting for an image to print onto mylar.

Optical Disector.

Make a counting frame on a blank image and ignore the rest of the macros (except possibly Set Scale). Then perform a live paste from the microscope and count objects while focusing. DO NOT CLICK THE MOUSE (OR TABLET) OR YOU WILL COMPLETE THE PASTE. This means doing analog (pencil and paper) counts.

Templates can be drawn onto a blank image window and then printed onto paper or mylar transparency film. These may be used with a drawing tube for numerical densities and point counts on microscope fields. Printing templates onto mylar allows either hand counting or use of a digitizing tablet and Image for working with micrographs. Mylar counting frames may also be simply taped to the monitor for optical disector counts.

Eyepiece reticules also make handy counting frames for optical dissectors. Those with subdivisions (e.g., 2 X 2, 5 X 5 or 10 X 10 reticules) allow counting sub-regions. Simply run the counting macros on a blank image to directly put data into a file.
Length Gauges (Microcator) for Optical Disectors.

Depth of focus must be measured for optical dissectors. A dial or digital hand micrometer can be easily mounted on most microscopes. The user notes a landmark at the desired depth, and returns to the starting depth. Cells are counted until the landmark is reached. The Heidenhain digital length gauges offer an elegant solution. The Heidenhain Metro sensor can be mounted on a base that may be inserted between the microscope base and some immobile part of the stage (i.e., some portion that doesn't move during X-Y sample movement). The model VRZ-401 lacks a serial output and is used as described above for a hand caliper. The model VRZ-405 provides an RS-232 serial output that can be monitored by NIH-Image. Length gauge macros on the NIH Image ftp site will alert the user when a preset depth has been reached. Since NIH Image cannot monitor run a macro and perform live paste at the same time, the depth alarm macro works best while using a counting frame based upon either an eyepiece reticule or a mylar image taped to the monitor.
Some Stereology References.

QM-2000, written by Dr. Robert Bolender, is a PC based tutorial on quantitative morphometry with examples, worksheets for computing results, power analysis and references is available from the Health Sciences Center for Educational Resources, University of Washington, Seattle, WA 98195 (US$185).

John Russ has contributed a set of macros for NIH-Image and a plug-in for IP Lab. Dr. Russ's contributions give a wide variety of templates and offer automatic point counting. It is available from zippy.nimh.nih.gov. Changes in tile area or placement must be made by editing the macro. This set of macros shares many characteristics with Dr. Russ' and borrows some of his code (cycloid rotation) and features (writing template data at the screen bottom).

The usual disclaimers apply. This documentation and the basic macros were originally written for the V.M. Bloedel Hearing Research Center and the Center for Human Development and Disability, University of Washington, Seattle, Washington.